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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Welcome to this Guide
Welcome to the HP LoadRunner Installation Guide. HP LoadRunner, a tool for performance testing,
stresses your entire application to isolate and identify potential client, network, and server
bottlenecks.

This guide describes how to install and set up HP LoadRunner.

How this Guide is Organized
This guide contains the following chapters:

Chapter 1: Before You Install

Provides you with the information that will help you prepare for the LoadRunner installation process,
including system requirements.

Chapter 2: Installing LoadRunner on Windows platforms

Describes how to install the full version of LoadRunner or a LoadRunner component on aWindows
platform.

Chapter 3: Installing the HP Load Generator on Linux platforms

Describes how to install and configure the LoadGenerator on a Linux platform.

Chapter 4: Viewing and Modifying a License

Describes how to enter, modify, or view LoadRunner license information.

Who Should Read this Guide
This guide is intended for users who need to install and set up LoadRunner. Readers of this guide
should have some knowledge of system administration.

LoadRunner Documentation
The LoadRunner Documentation set consists of the following guides and references, available
online, in PDF format, or both. PDFs can be read and printed using Adobe Reader, which can be
downloaded from the AdobeWeb site (http://www.adobe.com).

Accessing the Documentation

You can access the LoadRunner documentation as follows:

l After installing LoadRunner, click Start > All Programs > HP Software > HP LoadRunner >
Documentation and select the relevant document.
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l From the Controller, VuGen, or Analysis Helpmenu, click LoadRunner Help to open the
LoadRunner documentation.

Getting Started Documentation

l Readme. Provides last-minute news and information about LoadRunner. You access the
Readme from theStartmenu.

l HP LoadRunner Tutorial. Self-paced printable guide, designed to lead you through the process
of load testing and familiarize you with the LoadRunner testing environment. To access the
tutorial, click Start > All Programs > HP Software > HP LoadRunner > Documentation >
Tutorial.

LoadRunner Guides

l HP Virtual User Generator User Guide. Describes how to create scripts using VuGen. When
necessary, supplement this user guide with the onlineHP LoadRunner Function Reference.

l HP LoadRunner Controller User Guide. Describes how to create and run LoadRunner
scenarios using the LoadRunner Controller in aWindows environment. Also describes how to
set up the server monitor environment and configure LoadRunner monitors for monitoring data
generated during a scenario run.

l HP LoadRunner Analysis User Guide. Describes how to use the LoadRunner Analysis
graphs and reports to analyze system performance after running a scenario.

l HP LoadRunner Installation Guide. Explains how to install LoadRunner and additional
LoadRunner components.

LoadRunner References

l LoadRunner Function Reference. Gives you online access to all of LoadRunner’s functions
that you can use when creating Vuser scripts, including examples of how to use the functions.

l Analysis API Reference. This Analysis API set can be used for unattended creating of an
Analysis session or for custom extraction of data from the results of a test run under the
Controller. You can access this reference from the Analysis Helpmenu.

l Troubleshooting. TheOutput dialog box (Controller > View > Show Output) displays details of
any errors encountered during a scenario run. Click the icon in the Help column to open the
Troubleshooting guide. This guide provides clear explanations and troubleshooting tips for many
Controller connectivity andWeb protocol errors. It also provides general troubleshooting tips for
Winsock, SAPGUI, and Citrix protocols.

Documentation Updates

HP Software is continually updating its product documentation with new information.

To check for recent updates, or to verify that you are using themost recent edition of a document,
go to the HP Software Product Manuals Web site
(http://h20230.www2.hp.com/selfsolve/manuals).

Additional Online Resources
The following additional online resources are available from the LoadRunner Helpmenu:
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Resource Description

Troubleshooting
& Knowledge
Base

Opens the Troubleshooting page on the HP Software Support Web site
where you can search the Self-solve knowledge base. ChooseHelp >
Troubleshooting & Knowledge Base. The URL for this Web site is
http://h20230.www2.hp.com/troubleshooting.jsp.

LoadRunner
License Utility

Opens the LoadRunner License Utility dialog box. This dialog box displays a
summary of existing licenses and allows you to install more licenses. For
details, see the LoadRunner Installation Guide.

HP Software
Support

Opens the HP Software Support Web site. This site enables you to browse
the Self-solve knowledge base. You can also post to and search user
discussion forums, submit support requests, download patches and updated
documentation, andmore. ChooseHelp > HP Software Support Site. The
URL for this Web site www.hp.com/go/hpsoftwaresupport.
l Most of the support areas require that you register as an HP Passport

user and sign in. Many also require a support contract.

l To findmore information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp

l To register for an HP Passport user ID, go to:
http://h20229.www2.hp.com/passport-registration.html

HP Software
Web site

Opens the HP SoftwareWeb site. This site provides you with themost up-
to-date information on HP Software products. This includes new software
releases, seminars and trade shows, customer support, andmore. Choose
Help > HP Software Web site. The URL for this Web site is
www.hp.com/go/software

LoadRunner Terminology
Vuser A virtual user—a LoadRunner-created user that emulates a human user.

LoadGenerator
machine

The workstation used to host the LoadRunner Vusers.

Controller
machine

The computer used to host the LoadRunner Controller.

Vuser Group A collection of Vusers with common characteristics, such as themachine on
which they run, or the client that they use.
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Chapter 1

Before You Install
This chapter provides you with the information that will help you prepare for the LoadRunner
installation process. Before you install LoadRunner, please review the system requirements.

Introducing the LoadRunner Windows
Installation

Your LoadRunner installation disk includes a setup program that guides you through the process of
installing LoadRunner’s components. The setup program installs LoadRunner on the hard disk of a
single-user computer.

The LoadRunner installation installs a full LoadRunner configuration, including Vuser and server
side components.

For information about installing LoadRunner on aWindows platform, see "Installing LoadRunner on
Windows" on page 14.

Introducing the LoadRunner Linux Installation
You can install the LoadRunner LoadGenerator component on a Linux platform to run Vusers. The
Linux-based Vusers interact with the LoadRunner Controller, installed on aWindows platform.

For more information, see "Installing the HP LoadGenerator on Linux" on page 38.

Windows System Requirements
This section describes the system requirements necessary for installing the LoadRunner
components on aWindows platform.

Note: For HP Diagnostics system requirements, refer to the HP Diagnostics Installation and
Configuration Guide.

Controller, VuGen, and Analysis System Requirements 10

LoadGenerator forWindows System Requirements 11

Controller, VuGen, and Analysis System
Requirements

The following table describes the system requirements for installing the Controller, VuGen, and
Analysis.
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Processor CPU Type: Intel Core, Pentium, Xeon, AMD or compatible

Speed: 1GHz minimum. 2GHz or higher recommended

Operating System The followingWindows operating systems are supported:

l Windows XP Professional SP3 32-Bit

l Windows Server 2003 Standard Edition/Enterprise Edition SP2
32-Bit

l Windows Server 2008 Standard Edition/Enterprise Edition SP2
32-Bit and 64-bit

l Windows 7 SP1 32-bit and 64-bit

l Windows 2008 R2 SP1

l Windows 8

Memory (RAM) Minimum: 1GB

Note: Memory depends on protocol type and system under
test and can vary greatly.

Browser l Microsoft Internet Explorer 7.0

l Microsoft Internet Explorer 8.0

l Microsoft Internet Explorer 9.0

l Microsoft Internet Explorer10.0

 

Available Hard Disk
Space

Minimum: 2GB

Load Generator for Windows System
Requirements

The following table describes the system requirements for installing the LoadGenerator on a
Windows platform.

Processor CPU Type: Intel Core, Pentium, Xeon, AMD or

compatible

Speed: 1GHz minimum. 2GHz or higher recommended
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Operating System The followingWindows operating systems are supported:

l Windows XP Professional SP3 32-Bit

l Windows Server 2003 Standard

l Edition/Enterprise Edition SP2 32-Bit

l Windows Server 2008 Standard

l Edition/Enterprise Edition SP2 32-Bit and 64-bit

l Windows 7 SP1 32-bit and 64-bit

l Windows 2008 R2 SP1

l Windows 8

Memory (RAM) Minimum: 1GB

Note: Memory depends on protocol type and system under
test and can vary greatly.

Browser l Microsoft Internet Explorer 7.0

l Microsoft Internet Explorer 8.0

l Microsoft Internet Explorer 9.0

l Microsoft Internet Explorer 10.0

 

Available Hard Disk
Space

Minimum: 2GB

Note: For information about system requirements for installing the LoadGenerator on a Linux
platform, see "Meeting the System Requirements" on page 40.

Prerequisite Software
Specific software needs to be installed before you can install LoadRunner. When you run the
LoadRunner installation wizard, if the prerequisite software is not already installed on your
computer, the wizard detects which software is missing and provides the option to install it.

The following prerequisite software needs to be installed:

l Microsoft Windows Installer 3.1

l .Windows Imaging Component. This is a prerequisite for .NET Framework 4.0

l .NET Framework 3.5 SP1 (See the note below for installation instructions.)

l .NET Framework 4.0

l WebServices Enhancements (WSE) 2.0 SP3 for Microsoft .NET Redistributable RuntimeMSI
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l WebServices Enhancements (WSE) 3.0 for Microsoft .NET Redistributable RuntimeMSI

l Microsoft Core XML Services (MSXML) 6.0

l Microsoft Visual C++ 2005 SP1Redistributable PackageMFC Security Update (x86)

l Microsoft Visual C++ 2005 SP1Redistributable PackageMFC Security Update (x64)

l Microsoft Visual C++ 2008 SP1Redistributable PackageMFC Security Update (x86)

l Microsoft Visual C++ 2008 SP1Redistributable PackageMFC Security Update (x64)

l Microsoft Visual C++ 2010 SP1Redistributable PackageMFC Security Update (x86)

l Microsoft Data Access Components (MDAC) 2.8 SP1 (or later)

Note: Installing .NET Framework 3.5.1:

l Windows 7: .NET Framework 3.5.1 is installed by default.

l Windows 2008 R2: To install .NET Framework 3.5.1, click Administrative Tools >
Service Manager > Features. Click Add Features, select the .NET Framework 3.5.1
check box, and then click Install.

l Windows 8: The .NET Framework 3.5.1 is not automatically installed withWindows 8. To
run LoadRunner components, youmust enable .NET Framework 3.5.1 on your computer.
This can be done either by installing or running an application that requires .NET Framework
3.5.1, or by enabling .NET Framework 3.5.1 in the Control Panel. Both options require an
internet connection. For details, see: http://msdn.microsoft.com/en-
us/library/hh506443.aspx.

l All other supported versions of Windows: Install .NET Framework 3.5.1 using the .NET
Framework 3.5.1 installer.

Pre-installation Configuration
Before you begin the installation, review the following configuration information:

l To run the LoadRunner installation, youmust have full local administrative rights on the
designatedmachine.

l If any version of LoadRunner is installed on your machine, uninstall the current version before
you begin the new installation.

l You cannot use the UNC (Universal Naming Convention) path to run the installation. Therefore,
if the LoadRunner installation folder is located on a network drive, the network drive needs to be
mapped before you can run the installation.

l LoadRunner does not support installation via terminal service. Installationmust be performed at
the destinationmachine.

l You cannot install LoadRunner on amachine that contains an existing installation of HP
Performance Center or a standalone installation of Analysis, VuGen, or Service Test.

l If you are working with a non-English version of Windows, and your machine does not have an
Internet connection, .NET Framework 3.5 SP1must be installed before you run the LoadRunner
installation.
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Chapter 2

Installing LoadRunner on Windows
This chapter describes how to install the full version of LoadRunner or a LoadRunner component on
aWindows platform.

Performing the Installation
Caution: Before you install LoadRunner, review the pre-installation information, including the
system requirements, described in "Before You Install" on page 10.

To install LoadRunner or an additional component:

1. Disable UAC (User Account Control) and restart the computer.

For details on how to disable UAC, refer to your Microsoft Windows documentation.

Note: Disabling UAC is not applicable toWindows XP Professional andWindows Server
2003.

2. Run the setup.exe file in the root folder of the installation disk.

The LoadRunner installation program begins and displays the installationmenu page.
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3. Select the required installation option.

From the installationmenu page, select one of the following options:

n LoadRunner Full Setup. Installs themain LoadRunner components, including the
Controller, the Virtual User Generator (VuGen), Analysis, and the LoadGenerator. Use this
option for themachine that runs the load testing scenarios.

For details on the components that are included in the installation, see "LoadRunner
Installation Components" on page 25

n VuGen. Installs a standalone version of the LoadRunner Virtual User Generator, VuGen.

n Analysis. Installs a standalone version of LoadRunner Analysis.

n Load Generator. Installs the components needed for running Vusers to generate load. Use
this option for machines that are used to generate load only, and not to control Vusers.

n Monitors Over Firewall. Installs the components on the agent machine for monitoring over
the firewall. For more information, refer to the “Using Firewalls” chapter in the HP
LoadRunner Controller User Guide.

n MI Listener. Installs the components needed on theMI Listener machine used in running
Vusers over a firewall andmonitoring over a firewall. For more information, refer to the “Using
Firewalls” chapter in the HP LoadRunner Controller User Guide.

n Host ID. Opens the Host ID Generator that displays the computer’s Host ID.
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n Additional Components. Opens the Additional Components folder located in the root folder
of the LoadRunner installation disk. From this folder, you can install the following
components:

o Agent for Citrix Server

o Agent for Microsoft Terminal Server

o Assembly Crawler for Analysis API

o HostID Generator

o HP Diagnostics Mediator

o HP Performance Validation SDK

o IDE Add-Ins

o LRTCPDump

o Monitor Probe for Microsoft COM+ Server Components

o MQTester

o SAP Tools: SAPGUI Spy and SAPGUI Verify Scripting

o Standalone Applications: Analysis, LoadGenerator, MI Listener, Monitors over Firewall,
VTS (Virtual Table Server), and VuGen

o WinPcap

For a description of each of these components, see "Installing Additional Components" on
page 26.

4. If necessary, install prerequisite software.

Specific software, for example, .NET Framework 3.5 SP1, needs to be installed before you
can install LoadRunner. If the prerequisite software is not already installed on your computer, a
dialog box opens displaying the list of prerequisite programs that are required.
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Click OK to install the listed software before continuing with the LoadRunner installation. If you
click Cancel, the LoadRunner installer exits because LoadRunner cannot be installed without
the prerequisite software.

Note: For the full list of prerequisite software, see "Prerequisite Software" on page 12.

5. Start the LoadRunner installation.

The LoadRunner SetupWizard opens, displaying the welcome page.
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Click Next to proceed.

6. Review the License agreement.

If the terms of the license agreement are acceptable to you, select I Agree.
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Click Next to proceed.

7. Register the LoadRunner Installation on your computer.

In the Customer Information page, enter your name and organization name.
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Click Next to proceed.

8. Select an Installation folder.

Accept the proposed folder for the installation or browse to an alternate folder.
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Click Disk Cost to check the disk space for each drive. The dialog box displays the size,
available space, and required space for each disk.

Click OK to close the Disk Cost dialog box.

Click Next to proceed.

9. Start the installation process.

The wizard prompts you to confirm the installation.
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Click Next to start the installation. The Installing HP LoadRunner screen opens indicating the
progress of the installation.

10. Complete the installation process.

When the installation is complete, a wizard page opens, confirming successful installation.
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Click Finish to close the LoadRunner installation program.

11. Check your license information.

The LoadRunner installation is now complete. The LoadRunner License Utility opens,
displaying your LoadRunner license information.
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During the LoadRunner installation, if LoadRunner does not detect a valid license on your
computer, you are automatically granted a temporary 10-day license for 25 Vusers. To use
LoadRunner beyond the 10-day period, youmust request and enter license information for your
copy of LoadRunner. For more information, see "Viewing or Modifying a License" on page 50.

Click Close to close the LoadRunner License Utility.

Note:

l To uninstall LoadRunner, use theWindows Add/Remove Programs utility. Alternatively,
you can run the setup.exe file located in the root directory of the LoadRunner installation
disk, select LoadRunner Full Setup, and then select theRemove option in the setup
wizard.
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l To repair LoadRunner, run the setup.exe file located in the root directory of the LoadRunner
installation disk, select LoadRunner Full Setup, and then select theRepair option in the
setup wizard.

l If your version of LoadRunner is supplied with a plug and you have not already installed the
plug, do so now by inserting it in the parallel port.

l You can configure LoadRunner to run Vusers on a LoadGenerator machine without the
need for the user to manually log in to themachine. For more information, see "Configuring
User Login Settings" on page 34

LoadRunner Installation Components
The LoadRunner full installation includes the following components:

l Controller. Controls the execution of scenarios and Vusers. Includes the onlinemonitors which
monitor and display information about the test execution. Install the Controller only on the
computer that will control the Vusers.

l Analysis. Graphs and reports for analyzing the load test.

l ERP and CRM Mediator. The component needed to gather and correlate offline transaction
data for the ERP/CRM diagnostics modules. For more information, refer to the ERP/CRM
Diagnostics section in the HP LoadRunner Controller User Guide.

Note: TheMediator must be installed on amachine that resides in the same LAN as the
monitored ERP/CRM server, preferably on a dedicatedmachine. It is not recommended to
install theMediator on a Siebel or Oracle server that is involved in the load test.

By default, theMediator agent is installed to run as a process. It is recommended to
configure theMediator agent to run as a service. To configure the agent to run as a service,
see "Configuring User Login Settings" on page 34.

l Load Generator. The components for running Vusers (includingWindows-basedGUI Vusers)
to generate load.

l MI Listener Component. Components for theMI Listener machine used in running Vusers and
monitoring over the firewall. For more information, refer to the "Using Firewalls" chapter of the
HP LoadRunner Controller User Guide.

l Monitors over FireWall. Components on the agent machine for monitoring over the firewall.
For more information, refer to the Using Firewalls chapter of the HP LoadRunner Controller User
Guide.

l Online Documentation. All LoadRunner user guides in PDF format.

l Protocol SDK. Enables LoadRunner to work with the HP Performance Validation SDK. To
install this feature, you also need to install either the Vuser Generator or LoadGenerator.

You install the HP Performance Validation SDK from the Additional Components folder located
in the root folder of the installation disk.

l Samples. The LoadRunner sample flight application andWeb server.

HP LoadRunner (Service Pack 11.52)Page 25 of 59



Installation Guide
Chapter 2: Installing LoadRunner onWindows

l Vuser Generator [VuGen]. LoadRunner’s tool for creating virtual user (Vuser) scripts, primarily
through recording. Vuser scripts emulate users without a graphical user interface by using direct
function calls.

Installing Additional Components
You can install additional components that provide advanced features for working with LoadRunner.
You install these components from the following locations:

l TheAdditional Components folder inside the root folder of the LoadRunner 11.50 installation
DVD.

l HP Software Support Online (Help > HP Software Support Site). After logging in to the
support site, search for "LR 11.52 Additional Components", and download the file that
contains all the additional components. Unzip the file, and run the installation wizard for the
additional component that you want to install.

The table below indicates which additional components are available, and from where you should
install each component:

Folder Component Description
Install
on...

Agent for Citrix
Server
Install from HP
Software Support
Online.

Setup files
for 32 and 64
bit machines

Installs the Citrix Agent which enhances
VuGen’s capabilities in identifying Citrix client
objects. For installation instructions, see
"Installing the Citrix Server Agent" on page 30.

Citrix
Server

Agent for
Microsoft
Terminal Server
Install from HP
Software Support
Online.

Setup file for
MS Terminal
Agent

Installs a utility that enhances RDP
functionality in VuGen. For installation
instructions, see "Installing theMicrosoft
Terminal Server Agent" on page 31.

RDP
server

Assembly
Crawler for
Analysis API
Install from the
LoadRunner
11.50 DVD.

Setup file for
Assembly
Crawler
Console

Installs a command-line utility to build a .NET
configuration file for a LoadRunner Analysis
API application. For more information, open the
Analysis API Reference from the Start menu
(not available with VuGen Standalone).

Load-
Runner
Analysis
machine

HostID
Generator
Install from the
LoadRunner
11.50 DVD.

Host ID
Generator
tool

Opens the Host ID Generator utility that
displays the computer’s Host ID. This is useful
when requesting a license. For details, see
"Determining the Host ID" on page 30

Load-
Runner
Controller
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Folder Component Description
Install
on...

HP Diagnostics
Mediator
Install from the
LoadRunner
11.50 DVD.

Setup file Installs the HP Diagnostics Mediator, the
component that gathers and correlates offline
transaction data for the ERP/CRM diagnostics
modules. For details, seeERP/CRM
Diagnostics in the Controller section of the
LoadRunner User Guide.

On the
same LAN
as the
diag-
nostics
(e.g.
Oracle)
server

HP
Performance
Validation SDK
Install from HP
Software Support
Online.

Configuration
Builder Setup
file

Installs theConfiguration Builderwhich
allows you to create a custom protocol. For
more information, open theConfiguration
Builder from the LoadRunner group and click
F1 to open the Help.

VuGen
machine

IDE Add-Ins
Install from the
LoadRunner
11.50 DVD.

Add-in setup
files for
common
versions of
MS Visual
Studio

Installs add-ins for Visual Studio enabling you
to create Vuser scripts in your standard
development environment using the
LoadRunner API. This integration also allows
you to run the test directly from Visual Studio to
test its functionality. For details, see
Advanced Topics in the VuGen section of the
LoadRunner User Guide.

Visual
Studio
machine
with
VuGen

IDE Add-Ins
Dev
Install from HP
Software Support
Online.

Setup files
for developer
add-ins for
Visual Studio
2010 and
Eclipse

Installs add-ins for Visual Studio 2010 or
Eclipse enabling you to create NUnit or JUnit
tests in your standard development
environment using the LoadRunner API. The
unit test can be loaded directly into a scenario,
just as a Vuser script. This integration also
allows you to run NUnit, JUnit, or Selenium
tests directly from their development platform,
Visual Studio or Eclipse, to test its
functionality.

Note:After installing the Eclipse plugin, rebuild
the plugin cache by running the following from
the command line: Eclipse.exe -clean

Visual
Studio
2010 or
Eclipse
machine
with
VuGen
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Folder Component Description
Install
on...

LRTCPDump
Install from the
LoadRunner
11.50 DVD.

Command
line
executable
forWindows
and UNIX
platforms

Creates a trace file containing logs of TCP
traffic over the network. This can be used as an
alternative toWireshark.
Note:Youmust install WinPcap before using
this command.

ForWindows, usage is: lrtcpdump.exe -i
interface -f filenameYoumust provide a
filename. If you do not provide an interface, you
are prompted to choose one.

Any
machine
with
WinPcap

mobile
RemoteAgent
Install from the
LoadRunner
11.50 DVD.

Executable
files for
several
platforms

Starts theMongooseWeb server to provide
mobile functionality.

VuGen
machine

Monitor Probe
for Microsoft
COM+ Server
Components
Install from
LoadRunner
11.50 DVD.

Setup file for
the HP
COM+ Probe

Installs the probe utility that prepares the server
machine for COM+ monitoring. This is required
in order to use the Application Component
monitor. For details, see the Application
Component monitor in the Controller section of
the LoadRunner User Guide.

Any
machine

MQTester
Install from the
LoadRunner
11.50 DVD.

Readme and
Setup file for
MQTester

Installs MetaStorm’s MQTester for HP
LoadRunner. It allows you to test IBM
WebSphereMQ-based systems in a
LoadRunner environment.

Web-
sphereMQ
with
Load-
Runner
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Folder Component Description
Install
on...

SAP Tools
Install from the
LoadRunner
11.50 DVD.

Executable
files for
SapSpy and
Ver-
ifyScriptng

l SAPGUI Spy. Examines the hierarchy of
GUI Scripting objects, on open windows of
SAPGUI Client for Windows. To install
the SAPGUI Spy component, copy the files
mscomctl.ocx,Msflxgrd.ocx and
msvbvm60.dll from theSAP_
Tools\SapGuiSpy\System32VBdlls
directory to yourC:\WINNT\system32
directory and then register the files. To
register each file, open aRun box (Windows
button + R) and type: regsvr32 <File
name>. Run theSapSpy.exe file from the
SAP_Tools\SapGuiSpy folder.

l SAPGUI Verify Scripting. Verifies that the
SAPGUI Scripting API is enabled. Run the
VerifyScripting.exe file from theSAP_
Tools\VerifySAPGUI folder and follow the
instructions. For details, see the help files in
the same folder.

SAPGUI
client
machine
with
VuGen

Standalone
Applications
l Analysis,

VuGen, Load
Generator,
and VTS:
Install from
HP Software
Support
Online.

l MI Listener,
Monitors Over
Firewall:
Install from
the
LoadRunner
11.50 DVD.

Setup files
for
standalone
LoadRunner
components

This folder contains the setup files for following
standalone applications: Analysis, Virtual User
Generator (VuGen), LoadGenerator, MI
Listener, Monitors Over Firewall, and VTS
(Virtual Table Server) 32-bit and 64-bit. Run the
relevant application’s setup program and follow
the wizard’s instructions.

For more information about the VTS
installation, see "Installing VTS" on page 32.

N/A

Third Parties
Install from the
LoadRunner
11.50 DVD.

Source files Includes the source code for open source
packages that are incorporated into
LoadRunner, and which have licenses with
source distribution clauses.

Load-
Runner
machine
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Folder Component Description
Install
on...

WinPcap
Install from the
LoadRunner
11.50 DVD.

Setup file Installs WinPcap, theWindows Packet
Capture libraries, enabling you to capture
network traffic into a file. This is useful for
creating aWeb Services Vuser script from
captured traffic. For details, see
http://www.winpcap.org.

This is to be used in conjunction with the
additional component, LRTCPDump.

Any
machine

Determining the Host ID
LoadRunner licenses may be either locked or unlocked.

l Locked. A locked license can be installed only on the specific computer for which the license
was issued. You will need to provide the Host ID when purchasing a locked LoadRunner
license.

l Unlocked. Indicates that the license can be installed on any computer. You will not need to
provide the Host ID when purchasing an unlocked LoadRunner license.

To determine a Host ID, perform one of the following procedures on the computer for
which you require a Host ID:

l Click Start > All Programs > HP Software > HP LoadRunner > License > LoadRunner
License Utility. The HP LoadRunner License Utility opens and displays the computer's Host
ID.

Or

l Run the setup.exe file in the root folder of the LoadRunner installation DVD.

l In the LoadRunner Setup window, click Host ID. The Host ID Generator opens.

l Click Generate New. The Host ID is displayed.

Installing the Citrix Server Agent
The installation file for the Agent for Citrix Server is located on the LoadRunner installation DVD, in
theAdditional Components\Agent for Citrix Server folder.

Note: The agent should be installed on your Citrix server machine—not LoadGenerator
machines.

If you are installing a newer version of an agent, make sure to first uninstall the previous version
(see removal instructions below).

To install the Agent for a Citrix Server:
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1. If your server requires administrator permissions to install software, log in as an administrator
to the server.

2. If you are using a Remote Desktop connection (RDP) to install the agent onto amachine
runningWindows 2003, run the following command on the target machine before starting the
installation:

Change user /install

3. Locate the installation file, Setup.exe, on the product installation disk in the Additional
Components\Agent for Citrix Server\Win32 or ...\Win64 folder.

4. Follow the installation wizard to completion.

Note: After installation the agent is only active for LoadRunner invoked Citrix sessions—it is
not active for users who start a Citrix session without LoadRunner.

To disable the agent, youmust uninstall it.

To uninstall the Agent for Citrix Server:

1. If your server requires administrator privileges to remove software, log in as an administrator to
the server.

2. OpenAdd/Remove Programs in the server machine’s Control Panel. Select HP Software
Agent for Citrix Server 32 or 64 and click Change/Remove.

Installing the Microsoft Terminal Server Agent
The installation file for the Agent for Microsoft Terminal Server is located on the product installation
disk, under the Additional Components\Agent for Microsoft Terminal Server folder.

Note: The agent should be installed on your RDP server machine—not LoadGenerator
machines.

If you are upgrading the agent, make sure to uninstall the previous version before installing the next
one (see uninstallation instructions below).

To install the Agent for Microsoft Terminal Server:

1. If your server requires administrator permissions to install software, log in as an administrator
to the server.

2. If you are using a Remote Desktop connection (RDP) to install the agent onto amachine
runningWindows 2003, run the following command on the target machine before starting the
installation:

Change user /install

3. Locate the installation file, Setup.exe, on the LoadRunner DVD in theAdditional
Components\Agent for Microsoft Terminal Server folder.

4. Follow the installation wizard to completion.
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Note: To use the agent, youmust set the recording options before recording a Vuser script. In
the Start Recording dialog box, click Options. In the Advanced CodeGeneration node, check
Use RDP Agent.

To uninstall the Agent for Microsoft Terminal Server:

1. If your server requires administrator privileges to remove software, log in as an administrator to
the server.

2. OpenAdd/Remove Programs in the server machine’s Control Panel. Select HP Software
Agent for Microsoft Terminal Server and click Change/Remove.

Installing VTS
Two versions of VTS are available: 32-bit and 64-bit. You can install 32-bit VTS on both 32-bit and
64-bit operating systems; 64-bit VTS can be installed only on 64-bit operating systems.

Note: Do not install 64-bit VTS and 32-bit VTS on the samemachine.

To install VTS:

1. Run the appropriate VTS setup.exe file [SetupVTS_x64.exe orSetupVTS_x86.exe] that is
located in theAdditional Components\Standalone Applications folder in the LoadRunner
installationmedia. The VTS SetupWizard opens, displaying the welcome page.

2. Follow the online instructions to complete the VTS installation.

Note: At the end of the installation process, a shortcut for VTS is created and added to your
desktop. This shortcut gives you access to the VTS UI on the local machine. If you change the
port that is used to access the VTS UI, youmust manually update theURL property of the
shortcut. For details on how to change the VTS UI access port, seeConfiguring VTS in the
VTS online documentation.

If you are unable to access the VTS UI, make sure that the VTS Service service is started. To
start the VTS Service service, go to Control Panel > Systems & Security > Administration
Tools > Services. Right-click VTS Service and select Start.

If you are unable to access the VTS UI, make sure that theVTS Service service is started. To start
the VTS Service service, go toControl Panel > Systems & Security > Administration Tools >
Services. Right-click VTS Service and select Start.

Configuring the VTS Administration Server

During the VTS installation process, you need to specify the port that is used to access the VTS
server for administrative purposes.

To configure the VTS Administration server:

1. Begin the VTS installation process as described in "Installing Additional Components" on page
26. During the VTS installation process, the Configure VTS administration server screen
appears.
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2. In theAdmin UI server port box, enter 4000.

3. Click Next to continue with the installation. The Configure VTS screen appears.

4. Specify where to save the VTS data file.
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5. Make sure that theStart Virtual Table Server Automatically check box is selected.

6. Click Next, and then follow the wizard’s instruction to complete the VTS installation procedure.

Configuring User Login Settings
By default, you need tomanually log on to a computer before LoadRunner can run Vusers on that
computer. However, you can configure LoadRunner to run Vusers on a LoadGenerator machine
without the need for the Vuser to manually log in to themachine.

To configure user login settings:

1. Select Start > All Programs > HP Software > HP LoadRunner > Tools > Agent Runtime
Settings Configuration. The LoadRunner Agent Runtime Settings dialog box opens.

2. Select one of the following options:

n Allow virtual users to run on this machine without user login. LoadRunner
automatically logs on to the network from the LoadGenerator machine, so the Vusers can run
without any manual intervention. Enter the network domain where the user machine resides,
a user name, and password.

Note: The user specified in the automatic login must have administrator privileges on the
LoadGenerator machine.

n Manual log in to this machine. The user must manually log on to the network from the
LoadGenerator machine for each session of running Vusers.

3. Click OK.

Note: Youmust boot and log on to the system at least once after the LoadRunner
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installation before the automatic login can work.

4. Select Start > All Programs > HP Software > HP LoadRunner > Tools > Agent Runtime
Settings Configuration. The LoadRunner Agent Runtime Settings dialog box opens.

Silent Installation of LoadRunner
A silent installation is an installation that is performed automatically, without the need for user
interaction.

To perform a silent installation of LoadRunner:

1. Install the prerequisite software. For the full list of prerequisite software, see "Prerequisite
Software" on page 12. You can begin the silent installation only after all the prerequisite
software is installed.

2. To install all of the LoadRunner components, run one of the following commands from the
command line:

msiexec.exe /qn /i “<Installation_disk>\lrunner\MSI\LoadRunner_
x64.msi”

msiexec.exe /qn /i “<Installation_disk>\lrunner\MSI\LoadRunner_
x86.msi”

Note:

l Eachmachine on which you are installing LoadRunner requires administration privileges.

l LoadRunner MSI supports both 32 bit and 64 bit operating systems. Ensure that you run the
appropriate MSI version for your operating system.
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l Use StandardMSI command line options to define installation properties. For example, use
TARGETDIR to specify an alternate installation folder.

HP LoadRunner User Interface Pack
Installation

The HP LoadRunner User Interface Pack enables you to view the LoadRunner, VuGen Standalone,
and Analysis Standalone user interface in your local language. You install the User Interface Pack
from the <Language> User Interface Pack CD-ROM.

1. Make sure that HP LoadRunner is already installed. For details, see "Performing the
Installation" at the beginning of this chapter.

2. Insert the <Language> User Interface PackCD into the CD-ROM drive. The HP LoadRunner
<Language> User Interface Pack Setup window opens.

Note: If the CD-ROM drive is on a network computer, map the network drive, navigate to
the root folder of themapped network path, and double-click setup.exe.

3. Click the desired link (LoadRunner, Vugen Standalone, orAnalysis Standalone User
Interface Pack Setup) and follow the on-screen instructions.

The <Language> User Interface Pack is automatically installed in the location that was
specified during the installation of the HP LoadRunner.

Upgrading LoadRunner
Various options exist for upgrading your LoadRunner installation. The options vary depending on
your installed version of LoadRunner, and the version to which you want to upgrade.

Note: The details in this section apply if you are upgrading the full version of LoadRunner, or
one of the following LoadRunner components:

l VuGen standalone

l Analysis standalone

l LoadGenerator [Windows version]

Upgrading to LoadRunner 11.50

l If your installed version of LoadRunner is prior to version 11.00, uninstall LoadRunner and then
install LoadRunner 11.50. For details, see "Performing the Installation" on page 14.

l If you have LoadRunner 11.00 installed, install LoadRunner 11.50 as described in "Performing
the Installation" on page 14.

Upgrading to LoadRunner Service Pack 11.52
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Before you can install LoadRunner Service Pack 11.52, youmust have either LoadRunner 11.50 or
LoadRunner Service Pack 11.51 installed. To install LoadRunner Service Pack 11.52, run the
LoadRunner Service Pack 11.52 installation wizard, and then follow the online instructions.
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Installing the HP Load Generator on Linux
LoadRunner uses load generators to run Vusers. There are two versions of the LoadRunner Load
Generator. One version runs Vusers onWindows platforms, and the other version runs Vusers on
Linux platforms. You use aWindows-based Controller to control both theWindows-based and the
Linux-based Vusers.

This section describes how to install the LoadGenerator on a Linux platform. For details on how to
install the LoadGenerator on aWindows platform, see "Installing LoadRunner onWindows" on
page 14.

This section includes:
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Running the Linux LoadGenerator SetupWizard 41
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Understanding the Installation Process
Installing the HP LoadGenerator on a Linux platform involves the steps shown below:

1. Review the system requirements

Before you install the HP LoadGenerator on a Linux platform, make sure that your system
meets the requirements, as described in "Meeting the System Requirements" on next page.

2. Install the HP Load Generator

You install HP LoadGenerator using the HP LoadGenerator SetupWizard. For more
information, see "Running the Linux LoadGenerator SetupWizard" on page 41.

3. Configure your environment

Before you can begin working with the LoadGenerator you need to configure your environment.
This involves setting the appropriate environment variables, checking access to the Load
Generator, and verifying the installation. See "Configuring the Linux Environment" on page 43.
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Meeting the System Requirements
This section describes the hardware and software that are required for installing the HP Load
Generator on a Linux platform.

Hardware requirements

Requirement

Memory (RAM) 256MB minimum

Note: The exact memory depends on the types of Vuser protocols that
are run, and the system under test, and can vary greatly.

Available Hard
Disk Space

500MB minimum

CPU Type Intel Core, Pentium, AMD or compatible

CPU Speed 1GHz minimum. 2GHz or higher recommended

Supported Linux distributions

The following table lists the Linux distributions on which you can install a Linux LoadGenerator.
Both 32-bit and 64-bit versions of the distributions are supported.

Distribution Version

RedHat Enterprise Linux l RedHat Kernel 5.0

l RedHat Kernel 6.0

Oracle Enterprise Linux l Enterprise Linux 5.0

l Enterprise Linux 6.0

l Unbreakable Enterprise Kernel 5.6

l Unbreakable Enterprise Kernel 6.0

Ubuntu Server l 10.04 LTS

l 12.04 LTS

Amazon Linux l 2012.03 or later

Note: The HP LoadGenerator supports all X Servers.

Prerequisite packages for 64-bit installations

The following table lists the packages that must be installed before installing the 64-bit version of
HP LoadGenerator.
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Distribution Prerequisites* How to check if it is installed
How to
install

RedHat family
including Oracle Linux
and Amazon Linux

l glibc.i686 rpm -qa --qf '%{NAME}.%
{ARCH}\n' | grep -E 'glibc\.
(i686|i386)'

yum install
<package_
name>

l libstdc++.i686
(Oralce Linux 6)

l libstdc++.i686
(Redhat Linux 5,
Oralce Linux 5)

l libstdc++47.i686
(Amazon Linux)

rpm -qa --qf '%{NAME}.%
{ARCH}\n' | grep -E 'libstdc\+\+
[0-9]*\.(i686|i386)'

l ncurses-libs.i686
(needed by
SecurityConsole)

l ncurses.i386
(Redhat Linux 5)

rpm -qa --qf '%{NAME}.%
{ARCH}\n' | grep -E 'ncurses(-
libs)?\.(i686|i386)'

Ubuntu Server l libc6-i386

l lib32stdc++6

l dpkg -l libc6-i386

l dpkg -l lib32stdc++6

apt-get
install
<package_
name>l lib32ncurses5

(needed by
SecurityConsole)

Note: * The prerequisites listed in the table above indicate the naming patterns for the required
packages. Actual names may vary depending on the exact system architecture.

Running the Linux Load Generator Setup
Wizard

This section describes how to use the LoadGenerator SetupWizard to install the HP Load
Generator on a Linux platform.

For details on how to perform a silent installation, see "Performing a Silent Installation" on next
page.

Note: There are two versions of the LoadGenerator SetupWizard, a 32-bit version and a 64-bit
version.

l The 64-bit version checks that the required pre-requisite software is installed on the
computer. If any pre-requisite software is missing, amessage is displayed, and the setup
wizard will abort. Install the required package and then re-run the setup wizard.
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l The 32-bit version of the setup wizard does not check that the pre-requisite software is
installed.

Make sure that you run the correct version for your Linux installation.

To run the Load Generator Setup Wizard:

1. Change directory to /<installation root directory>/InstData/Linux/VM.

2. [sh and bash shells] Launch the setup wizard by typing: source ./installer.sh.

[csh and tcsh shells] Launch the setup wizard by typing: ./installer.sh.

Note: It is recommended that you use the source command to run the setup wizard, as
shown above. If you run the setup wizard without using the source command, youmust
set the environment variables for the current shell session. For details, see "Setting the
Environment Variables" on next page.

Follow the online instructions to install the HP LoadGenerator.

Note: If you encounter an error during the installation, see "Troubleshooting" on page 56
for a possible solution.

3. Configure your environment

After you install the LoadGenerator, configure your environment as described in "Configuring
the Linux Environment" on next page.

Performing a Silent Installation
To perform a silent installation of the HP LoadGenerator, follow the procedure below:

1. Change the current directory to the installer directory:

cd <path_to_installer_cd>/InstData/Linux/VM

2. Run the following command to silent-install the LoadGenerator:

source ./installer.sh -i silent

Note: It is recommended that you use the source command to perform the silent
installation, as shown above. If you perform the installation without using the source
command, youmust set up the environmental variables after installing the Load
Generator. For details, see "Setting the Environment Variables" on next page.

If you encounter an error during the installation, see "Troubleshooting" on page 56 for a
possible solution.
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By default, the LoadGenerator will be launched at the end of the installation. If you do not want
to automatically launch the LoadGenerator, run the source command using the following
command-line option:

source ./installer.sh -i silent –DSTART_PRODUCT _AFTER_
INSTALL=No

Configuring the Linux Environment
This section describes the configuration steps you need to complete after installing the Load
Generator, before you can begin working with the LoadGenerator.

To complete the setup process after installing the LoadGenerator:

1. Set the appropriate environment variables.

See "Setting the Environment Variables" below.

Note: If you used the source command to install the LoadGenerator, the setup wizard
automatically sets the appropriate environment variables - and there is therefore no need
to perform this step.

2. Verify the LoadGenerator installation.

See "Verifying the Linux Installation" on next page.

3. Check that the Controller can access the LoadGenerator.

See "Checking the Controller Connection" on page 45.

Setting the Environment Variables

Note: This topic is applicable only if you ran the LoadGenerator SetupWizard without using
the source command. If you used the source command, there is no need to perform any of the
procedures described below.

To enable the LoadGenerator to run, the following environment variables must be defined:

l M_LROOT. The location of the Linux LoadGenerator installation directory.

l PATH. The location of the Linux LoadGenerator bin directory.

The LoadGenerator SetupWizard performs the following tasks relating to the environment
variables:

l Adds the environment variable definitions to the system-wide startup scripts.

If the variable definitions were not correctly set during the setup, see "Troubleshooting" on page
56 for possible solutions.

l Sets environment variables for the current shell session if the source commandwas used to run
the setup wizard.
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This topic describes how to set the environment variables for the current shell session if the
source commandwas not used to run the setup wizard.

To determine if environment variables are set, run verify_generator (see "Running verify_
generator" on next page) or use the following command:

echo $M_LROOT

If the name of the LoadGenerator installation folder is returned, then the environment variables are
correctly set for current shell. If the name of the LoadGenerator installation folder is not returned,
thenmanually set the variables as described below.

Tomanually set the environment variables for the current shell session (if the source command
was not used to run the setup wizard) , execute one of the following commands:

l Bash users:

source <Load Generator installation directory>/env.sh

l C Shell users:

source <Load Generator installation directory>/env.csh

Verifying the Linux Installation
The LoadGenerator installation includes a setup verification utility, verify_generator, that checks
the LoadGenerator setup on your Linux machine. The verification utility checks environment
variables and your startup scripts (/etc/csh. cshrc, ${HOME}/.cshrc or /etc/profile, ${HOME}
/.profile) to verify that they are set up correctly.

It is strongly recommended that you run the verify_generator utility after installing the HP Load
Generator, before attempting to invoke the LoadGenerator. For details on how to run the verify_
generator utility, see "Running verify_generator" on next page.

The verify_generator utility checks the following:

l All the prerequisite software is installed. (This check is performed for 64-bit installations only.)

l There are at least 128 file descriptors

l The .rhosts permissions have been defined properly: -rw-r--r--

l The host can be contacted by using rsh to the host. If not, it checks for the host name in .rhosts

l M_LROOT is defined

l .cshrc or .profile defines the correctM_LROOT

l /etc/csh.cshrc, ${HOME}/.cshrc or /etc/profile, ${HOME}/.profile defines the
correctM_LROOT

l .cshrc or .profile exists in the home directory

l The current user is the owner of the .cshrc or .profile
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l A Linux LoadGenerator installation exists in $M_LROOT

l The executables have executable permissions

l PATH contains $M_LROOT/bin, and /usr/bin

l The rstatd daemon exists and is running

Running verify_generator
It is recommended that you run the verify_generator utility after installing the HP LoadGenerator,
before attempting to invoke the LoadGenerator. For details on what is checked by the verify_
generator utility, see "Verifying the Linux Installation" on previous page.

Note: To run this command, youmust be a "normal" user and not root user.

1. From the <Load Generator installation directory>/bin, run the following command:

verify_generator

For example:

/opt/HP/HP_LoadGenerator/bin/verify_generator

If you want to receive detailed information about the checks, you can use the -v option, as
follows:

verify_generator -v

2. View the results.

n If the settings are correct, verify_generator returns OK.

n If any of the settings are incorrect, verify_generator returns Failed, and suggestions on how
to correct the setup.

Checking the Controller Connection
If the LoadRunner Controller will connect remotely to the LoadGenerator using rsh (remote shell),
you need tomake sure that the LoadGenerator can be remotely accessed by the Controller.

1. On the LoadGenerator machine, locate the .rhosts file which is located in the user home
directory.

2. In the .rhosts file, verify that the Controller is included in the list of machines. If it is not listed,
add it to the list.

If the Controller still cannot connect to the LoadGenerator, contact your system administrator.

Connecting to a Linux Load Generator Without Using rsh

You can configure the Controller to connect to the LoadGenerator without using rsh. In this case,
you need to activate the agent daemon on the LoadGenerator, as described below.
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This section describes how to connect to a Linux LoadGenerator without using rsh.

1. On the Linux LoadGenerator, run the agent daemon by entering the following command from
<Load Generator installation directory>/bin:

m_daemon_setup -install

This runs a daemon calledm_agent_daemon, and if successful, you receive amessage:m_
agent_daemon <process ID>.

The agent now keeps running, even if the user is logged off. You can stop the agent by using
the command explained in step 9 below, or by rebooting themachine.

Note: If you look at them_agent_daemon[xxx].log log file in the temp directory, youmay
see communication errors, even if the installation succeeded.

2. In the Controller, select Scenario > Load Generators. The LoadGenerators dialog box
opens.

3. Click Add. The LoadGenerators dialog box opens.

4. In theName box, enter the name of the computer on which the LoadGenerator is running.

5. From thePlatform list, select Linux.

6. Click More.

7. Click the Linux Environment tab, andmake sure that theDon’t use RSH check box is
selected.

8. Connect as usual.
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9. To stop the agent daemon, run the following command from the <LR_root>/bin directory:

m_daemon_setup -remove

This stops them_agent_daemon daemon, and if successful, you receive amessage:m_
agent_daemon is down.

Upgrading the Linux LoadRunner Load
Generator

If you have a previous version of the Linux LoadGenerator installed and you want to upgrade to
version 11.52, run the LoadGenerator SetupWizard. The SetupWizard will first uninstall the
previous version, and will then install version 11.52. For details on how to run the setup wizard, see
"Running the Linux LoadGenerator SetupWizard" on page 41.

Uninstalling the HP Load Generator
You can use the LoadGenerator SetupWizard to uninstall the HP LoadGenerator, as described
below. Note that the last step in the procedure enables you to perform either a regular uninstall or a
silent uninstall.

1. Make sure that you are logged in as the same user who installed the HP LoadGenerator.

2. Change the current directory to the installation directory:

cd <path_to_installation_folder>/_HP_LoadGenerator_Installation

3. Run the following command, and then follow the instructions in the wizard to uninstall the HP
LoadGenerator:

sh ./Change_HP_LoadGenerator_Installation

To perform a silent uninstall, run the following command:

sh ./Change_HP_LoadGenerator_Installation -i silent

Recommended Configuration
You can increase the number of file descriptors, process entries, and amount of swap space by
configuring the kernel, as described in this chapter.

Note: Most operating systems using the Linux LoadGenerator have sufficient default file
descriptors, process entries, and swap space, and rarely require reconfiguration.

This section includes recommendations for improving LoadGenerator performance.

This section includes:
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Increasing File Descriptors 48

Increasing Process Entries 49

Increasing Swap Space 49

Increasing File Descriptors
A LoadGenerator uses the following File Descriptor resources:

l 14 file descriptors for the launch service

l 20 file descriptors for the agent

l 30 file descriptors for each Vuser driver. By default, there is a driver for every 50 Vusers.

l File descriptors for the running Vusers. Each Vuser requires two descriptors.

For example, to compute the number of file descriptors used in running 100 threaded Vusers, the
LoadGenerator requires:

Descriptors Purpose of the descriptors

14 For the launcher

20 For the agent

60 For 2 drivers (30 x 2, each one drives 50 Vusers)

200 For 100 Vusers (each Vuser requires 2)

Total: 294 File Descriptors

If Vusers are run as processes instead of threads, one driver is run per Vuser. Therefore, each
Vuser requires 30 file descriptors.

The procedure to increase the number of file descriptors differs between shells.

In the examples below, the number of descriptors is increased to themaximum of 1024.

l For sh and ksh users, type:

ulimit -n 1024

l For csh users, type:

limit descriptors 1024

Below is an alternate procedure to increase file descriptors. In this example, the number of
descriptors is increased to themaximum of 8192.

1. Add the following line to the /etc/security/limits.conf file:

hard nfile 8192
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2. Add the following line to the /etc/sysctl.comf file:

fs.file-max = 8192

3. Reboot themachine.

Increasing Process Entries
Each Vuser requires several free process entries. To increase the number of process entries on
your system, youmust reconfigure the kernel.

This section describes how to reconfigure the kernel for Linux platforms.

1. Locate the /etc/security/limits.conf file.

2. Set themaximum number of processes in the limits file. Type:

hard nproc 8192

3. Reboot themachine.

Increasing Swap Space
Each Vuser requires swap space ranging from 200 KB to 4MB. Before adding space to your
system configuration, you should determine your paging requirements. For environments running
programs with very largememory requirements, it is recommended to have paging space of four
times the physical memory. If you do not have enough paging space, certain processes may be
killed, and others will be unable to start.
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Viewing or Modifying a License
To run Vusers from the LoadRunner Controller, you need the appropriate LoadRunner licenses.
These licenses must be available on the computer on which the LoadRunner Controller is installed.
You use the LoadRunner License Utility to manage your LoadRunner licenses. The LoadRunner
License Utility enables you to:

l View the details of licenses that are currently installed

l Install additional licenses

During the LoadRunner installation, if LoadRunner does not detect a valid LoadRunner license on
your computer, you are automatically issued with a temporary 10-day license for 25 Vusers. To use
the Controller beyond the 10- day period, youmust request and enter additional license information
for your LoadRunner installation.

This chapter describes how to use the HP LoadRunner License Utility to view, enter, andmodify
license information.

Installing a New License
After you receive your license information from your HP representative, you can use the HP
LoadRunner License Utility to enter the license information.

Using the LoadRunner License Utility, you can install a new license by using either a license file or
a license key.

l License file.When you purchase a new license, HP may send you an email with an attached
license file. The license file contains the license keys for one or more licenses. When you use
the license file to install the new licenses, the LoadRunner License Utility reads the license file
and extracts all the license keys that are included in the license file. You can then select which
of the available licenses to install. Youmay choose to use a license file to install LoadRunner
licenses because the license file enables you to install multiple licenses simultaneously.

l License key. Unlike a license file, a license key enables you to install just a single license at a
time. Youmay receive the license key directly from HP, or the license key may be included in a
license file that you receive from HP.

To install a new LoadRunner license:

1. Click Start > All Programs > HP Software > HP LoadRunner > License > LoadRunner
License Utility. The HP LoadRunner License Utility opens.

2. In the LoadRunner License Utility, click Install New Licenses. The LoadRunner License
Utility - New License dialog box opens.

To install using a license file

3. Click theBrowse button to the right of License file, and locate the license file that was sent to
you by HP.
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4. Click View License File Content to display details of the licenses that are included in the
license file.

5. In the list of licenses included in the license file, select the licenses to install.

To install using a license key

6. Click Install a license using a license key.

7. Enter the license key that you received from HP.

To complete the installation

8. Click Install. The selected licenses are installed.

9. Click Close. In the License Summary table, make sure that the new licenses appear in the list
of installed licenses.

Viewing License Information
You can use the HP LoadRunner License Utility to view your license information.

To view your license information, click Start > All Programs > HP Software > HP LoadRunner
> License > LoadRunner License Utility. The HP LoadRunner License Utility opens.
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The HP LoadRunner License Utility displays the following information:

l Host ID. Identifies the computer on which the Controller is installed. Youmay need to provide
the Host ID when purchasing new LoadRunner licenses. To obtain new LoadRunner licenses,
click the Contact HP to purchase a new license link at the bottom of the LoadRunner License
Utility.

l License Summary. Displays a list of the LoadRunner licenses that are installed on the
Controller computer. Click on any license in the table to display additional details about the
license. The Vuser protocols included in the selected license box displays a list of the Vuser
protocols that are included in the selected license.

l Status. Indicates the status of the license.
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n Valid. Indicates that the license in current and functional.

n Invalid. Indicates that the license is no longer valid. An Evaluation license or an Instant on
license becomes invalid if a Time limited, Permanent, or VUD license is installed for the
same Vuser bundle. A VUD license becomes invalid when the remaining capacity is zero. By
default, the License Summary table does not show invalid licenses. Select the Include invalid
licenses check box to show invalid licenses. Note that a licensemay become temporarily
invalid if the LoadRunner License Utility detects that the system clock has been tampered
with. To restore the affected licenses, reset the system clock to the current time.

n To be Expired. Indicates that the license will expire within 30 days.

l Locked.

n Locked. Indicates that the license can be installed only on the computer on which it is
currently installed – not on any other computer.

n Unlocked. Indicates that the license can be installed on any computer.

l License Bundle. Indicates the name of the Vuser protocol bundle to which the license applies.
The license enables the Controller to run Vusers of any protocol that is included in the protocol
bundle. To display a list of the Vuser protocols that are included in a bundle, click the license in
the License Summary table. A list of the associated Vuser protocols is displayed at the bottom
of the LoadRunner License Utility.

Note that a Partner License icon that appears to the left of a license bundle indicates that the
license is for a LoadRunner partner, and not for standard LoadRunner Vuser protocols. Partner
licenses enable third-party applications to be controller by the LoadRunner Controller. Partner
licenses operate the same as standard LoadRunner licenses.

l Type. Indicates the type of license:

n Instant On licenses are installed when LoadRunner is first installed. Note that the expiration
date of an Instant On license is calculated based on the date on which LoadRunner is first
installed. You cannot extend theExpiration Date of an Instant On license by uninstalling
and then reinstalling LoadRunner.

n Evaluation licenses are supplied to enable potential customers to evaluate LoadRunner
functionality.

n Time limited licenses are valid for a limited period only. Time limited licenses are typically
issued for 60 or 365 days.

n Permanent licenses do not expire - there is no time limit to the validity of these licenses.

n VUD licenses are issued with a limited capacity. The capacity is defined by themeasurement
Vuser-days or VUDs. For example, the capacity of a VUD licensemay be 1000 VUDs. Each
day that the Controller is used to run Vusers, themaximum number of Vusers that ran
simultaneously on that day is deducted from the remaining license capacity. If a maximum of
200 Vusers ran on day 1, then 800 VUDs remain in the license.

For example, assume that you purchase a license for 100 VUDs, and then run 3 different
scenarios within the same 24 hour period, with 20 Vusers in each scenario. At the end of that
period, only 20 VUDs (and not 60) are deducted from your total number of available VUDs,
leaving you with 80 remaining VUDs which can be used at any time in the future.
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l Expiration Date. Indicates the date and time when Time limited, Instant on, andEvaluation
licenses expire.

l Capacity. Indicates the capacity of the selected license:

n For Instant on, Evaluation, Time Limited, andPermanent licenses, Capacity indicates
themaximum number of Vusers [of the type specified by the license bundle] that can be run
simultaneously from the LoadRunner Controller.

n For VUD licenses, Capacity indicates the number of VUDs that remain in the license.

l Show invalid licenses. Select this check box to show invalid licenses in the list of LoadRunner
licenses that are installed.

l Vuser protocols included in the selected license. Displays the Vuser protocols that are
included in the selected license.

l Install New Licenses. Opens the New License dialog box which enables you to install new
LoadRunner licenses.

Generating a Host ID
LoadRunner requires the appropriate licenses to run Vusers from the Controller. The licenses may
be either locked or unlocked.

l Locked. Indicates that the license can be installed only on the computer on which it is currently
installed – not on any other computer. The computer is identified by the Host ID. For details on
how to determine the Host ID for your computer, see "Determining the Host ID" on page 30.

l Unlocked. Indicates that the license can be installed on any computer.

Troubleshooting Licenses
If you have a temporary license, contact HP Customer Support to obtain a permanent license.

If LoadRunner does not accept your license key, perform the following checks:

l Make sure you typed in the license key exactly as it was given to you. The license key must
include the required spaces. The license key is case sensitive.

l If you receive a permission denied error message during Controller startup, youmust grant Full
Control permission for the Registry's HKEY_LOCAL_MACHINE key and in theWINNT folder
(the folder whereWindows is installed), as described below.

To add Registry permissions:

1. Run regedt32 to modify the registry.

2. Select the HKEY_LOCAL_MACHINE key.

3. Select Security > Permissions.

4. Add Full Control permission to the user that is running the Controller.

5. Turn on theReplace Permission on the Existing Subkeys flag.

6. Click OK.
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To add permissions on an NTFS file system:

1. Select the <System Drive>:\WinNT folder.

2. InvokeProperties.

3. Select theSecurity tab.

4. Click Permissions.

5. Add Full Control permission for the user.

6. Turn on theReplace Permissions on Subdirectories flag.

7. Click OK.
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Troubleshooting
This topic describes troubleshooting tasks relating to the setup of the Linux LoadGenerator.

Environment variables were not set correctly in the system-wide startup scripts

To enable the LoadGenerator to run, the system-wide startup scripts must bemodified to set
specific environment variables. The requiredmodifications to the startup scripts aremade by the
LoadGenerator SetupWizard. If the startup scripts were not correctly modified during the setup of
the LoadGenerator, you canmanually make the required changes to the startup scripts as
described below. The required changes differ slightly between C shell users, and Bourne and Korn
shell users.

l Manually modifying the startup scripts for C shell users

During the LoadGenerator installation process, the setup wizard creates the env.csh script.
This script includes the commands to set the required environment variables for C shell users. A
sample env.csh script is shown below.

setenv PRODUCT_DIR <Load Generator installation directory>

setenv M_LROOT ${PRODUCT_DIR}

if ( ! $?PATH ) then

setenv PATH ""

endif

setenv PATH ${M_LROOT}/bin:${PATH}"

Add the following line to the /etc/csh.cshrc or ~/.cshrc startup script to execute the env.csh
script during the shell startup:

source <Load Generator installation directory>/env.csh

For example:

source /opt/HP/HP_LoadGenerator/env.csh

The effect of making the abovemodification to the startup script is similar to themodifications
that aremade by the setup wizard. A sample of themodifications that the setup wizardmakes to
the /etc/csh.cshrc startup script is shown below:

# New environment setting added by HP_LoadGenerator on Wed Jan 30
16:20:10 IST 2013 2.
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# The unmodified version of this file is saved in
/etc/.login1557000131.

# Do NOT modify these lines; they are used to uninstall.

setenv PRODUCT_DIR "/opt/HP/HP_LoadGenerator"

# End comments by InstallAnywhere on Wed Jan 30 16:20:10 IST 2013
2.

# New environment setting added by HP_LoadGenerator on Wed Jan 30
16:20:10 IST 2013 5.

# The unmodified version of this file is saved in
/etc/.login1557000131.

# Do NOT modify these lines; they are used to uninstall.

setenv M_LROOT "/opt/HP/HP_LoadGenerator"

# End comments by InstallAnywhere on Wed Jan 30 16:20:10 IST 2013
5.

# New environment setting added by HP_LoadGenerator on Wed Jan 30
16:20:10 IST 2013 8.

# The unmodified version of this file is saved in
/etc/.login1557000131.

# Do NOT modify these lines; they are used to uninstall.

if ( ! $?PATH ) then

setenv PATH ""

endif

setenv PATH "/opt/HP/HP_LoadGenerator/bin:${PATH}"

# End comments by InstallAnywhere on Wed Jan 30 16:20:10 IST 2013
8.

l Manually modifying the startup scripts for Bourne and Korn shell users

During the LoadGenerator installation, the setup wizard creates the env.sh script. This script
includes commands to set the required environment variables for Bourne shell and Korn shell
users.

Add the following line to the /etc/profile or ~/.profile startup script to execute the env.sh script
during the shell startup:

source <Load Generator installation directory>/env.sh

For example:

source /opt/HP/HP_LoadGenerator/env.sh
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The effect of making the abovemodification to the startup script is similar to themodifications
that aremade by the setup wizard. A sample of themodifications that the setup wizardmakes to
the /etc/profile startup script is shown below:

# New environment setting added by HP_LoadGenerator on Fri Jan 18
11:14:24 IST 2013 1.

# The unmodified version of this file is saved in
/etc/profile1806316421.

# Do NOT modify these lines; they are used to uninstall.

PRODUCT_DIR=/opt/HP/HP_LoadGenerator

export PRODUCT_DIR

# End comments by InstallAnywhere on Fri Jan 18 11:14:24 IST 2013
1.

# New environment setting added by HP_LoadGenerator on Fri Jan 18
11:14:24 IST 2013 4.

# The unmodified version of this file is saved in
/etc/profile1806316421.

# Do NOT modify these lines; they are used to uninstall.

M_LROOT=/opt/HP/HP_LoadGenerator

export M_LROOT

# End comments by InstallAnywhere on Fri Jan 18 11:14:24 IST 2013
4.

# New environment setting added by HP_LoadGenerator on Fri Jan 18
11:14:24 IST 2013 7.

# The unmodified version of this file is saved in
/etc/profile1806316421.

# Do NOT modify these lines; they are used to uninstall.

PATH="/opt/HP/HP_LoadGenerator/bin:${PATH}"

export PATH

# End comments by InstallAnywhere on Fri Jan 18 11:14:24 IST 2013
7. LoadRunner settings #PATH=${M_LROOT}/bin:$PATH; export PATH

Error when installing the Load Generator on a Linux platform:

When you use the source installer.sh command to install the LoadGenerator [version 11.52] on a
Linux machine on which the LoadGenerator [version 11.52] was previously installed, youmay
receive the following error message:

"An error occurred while trying tomanage the selected instance."

Solution:
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1. Open the registry file /var/.com.zerog.registry.xml and locate the element "product" with
attribute "name"="HP_LoadGenerator".

For example: <product name="HP_LoadGenerator" id="77f695c1-1f0c-11b2-883d-
c486a85f6555" version="11.52.0.0" copyright="2012" info_url="http://www.hp.com" support_
url="http://www.hp.com" location="/opt/HP/HP_LoadGenerator" last_modified="2013-01-
21 13:12:14">

2. Record the value of the "location" attribute.

3. Remove the entire directory that is referred to by the "location" attribute.

4. Delete the registry file /var/.com.zerog.registry.xml.

5. Rerun the source installer.sh command.

Environment variables are not unset after uninstalling the Load Generator

When you uninstalled the Linux LoadGenerator, the setup wizardmight not have unset the Load
Generator environment variables (M_LROOT, PRODUCT_DIR, and PATH) for the current shell.
To unset the environment variables, close the current shell session and invoke a new one, or
manually unset the variables as described below:

l To unset theM_LROOT and PRODUCT_DIR variables:
n [bash shells] Use the unset command.

n [csh shells] Use the unsetenv command.

l To update the PATH variable to exclude the LoadGenerator binary directory, type:
n [bash shells] PATH=<required list of paths>; export PATH

n [csh shells] setenv PATH <required list of paths>

Unable to run Vusers on the Load Generator

If you are unable to run Vusers on the LoadGenerator, no specific error is reported, and the Vuser
protocol requires a third-party application or client to be present on LoadGenerator side, check the
dynamic libraries used by the application. This will enable you to establish if any shared objects
cannot be found. A shared object that cannot be foundmay indicate either amissing prerequisite
package or an environment variable issue.

To check the dynamic libraries used by an application, type:

ldd application_name

For example, type ldd mdrv to determine if all the dependencies of themdrv executable can be
found. If any dependencies are not found, run verify_generator as described in "Running verify_
generator" on page 45.

Note: If you are running Vusers for a protocol that requires a client installation (for example,
Oracle), make sure that the path for the client libraries is included in the dynamic library path
environment variable (LD_LIBRARY_PATH or SHLIB_PATH).
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